Real-Time fMRI Data Analysis with Turbo-BrainVoyager — Overview

Rainer Goebel

Maastricht Brain Imaging Center (M-BIC), Dept. of Cognitive Neuroscience, Maastricht University & National Institute of Neuroscience (NIN) of the Royal Netherlands Academy of Arts and Sciences, Amsterdam, The Netherlands & CEO Brain Innovation & CSTO Brains Unlimited
Real-time fMRI

- Can be used to analyze fMRI data directly *during image acquisition*, allowing “online” observation of the working brain.

- Allows for *quality assurance*: How much head motion? Are statistical maps and time courses o.k.? Stop scanning if enough data or repeat runs if data does not (yet) fulfill statistical criteria.

- Allows “*adaptive*” fMRI experiments: The decision when to start the next level of a subject-specific experiment can be based on observed levels of activity in brain areas (reflecting e.g. learning).

- Prerequisite for advanced applications such as *neurofeedback* and *communication BCI*. 
Real-Time fMRI

Statistical evaluation can be performed by a t-threshold $t_{\text{thresh}}$ (Cox, 1995, converted for correlation as $r_{\text{thresh}}$). A better approach is to use a fixed multiple correlation coefficient expressing the amount of explained variance.

First real-time fMRI study by Cox 1995:
- One EPI slice, 8mm thick, TR = 2000ms
- 64x64, 96x96 matrix, no motion correction
- Task: Finger tapping with both hands
- Reference vector: on-off box car

Limitations of real-time fMRI:
- No correction for serial correlations
- Correction for multiple comparisons
Flow Chart of Basic fMRI Data Analysis Steps

- Recorded time series (EPI)
- Correction of head motion
- Spatial and temporal filtering
- Coregistration of functional and anatomical data
- Spatial normalisation
- Statistical localization of brain activation, functional maps
- Anatomical images
- Segmentation Cortex reconstruction
- Single subject analysis
- Group analysis I
- Talairach space
- Fixed effects
- Random effects

- Coregistration of functional and anatomical data
  - Spatial normalisation
  - Statistical localization of brain activation, functional maps
  - Anatomical images
  - Segmentation Cortex reconstruction
  - Single subject analysis
  - Group analysis I
  - Talairach space
  - Fixed effects
  - Random effects
Real-Time fMRI - Principles and Applications

Real-Time fMRI

During functional runs, the following computations are repeatedly performed in real-time fMRI within the time window of one data point (one functional brain volume):

- Reading of EPI slices into working memory
- 3D motion correction (with GP-GPU sinc interpolation)
- 3D spatial smoothing (optional)
- Incremental statistical analysis (RLS GLM)
- Drift removal via design matrix (confound predictors)
- Slice scan time correction using shifted predictors per slice
- Incremental event-related averaging
- Real-time ICA (Esposito et al. 2003, *Neuroimage*, 20, 2209)
- Real-time SVM Classifier (LaConte et al., 2007; Sorger et al., 2010)
- Thresholding, clustering and color-coding of resulting statistical maps
- Advanced visualizations in volume and surface space (Goebel, 2001)
- Support for fast sampling (multi-band sequences) and 7+ Tesla scanners
Release Notes

Version 3.2

Turbo-BrainVoyager 3.2 provides the following new features and enhancements:

- **Neurofeedback based on Pattern Classifier.** The real-time pattern classification tool introduced in the previous version can now be used as a source for generating classification-based neurofeedback signals. More specifically, it is now possible to use the gradual output value(s) of a trained (multi-class) classifier to generate delayed or moment-to-moment feedback signals. The Neurofeedback dialog contains new options to choose the output from a running SVM classifier as input for the thermometer display. For moment-to-moment feedback, the Real-Time Classification dialog now supports not only the possibility to generate classifier output at the end of a trial but also at each time point during (shifted) protocol conditions.

- **SVM Access Plugin.** The plugin interface has new commands to access raw classifier output signals for custom processing, e.g., for advanced brain-computer interface (BCI) applications, or for specific calculations for custom neurofeedback visualizations. The new commands are described in the plugin interface documentation and demonstrated in the source code of the provided "Example Plugin - SVM Access" plugin; a compiled version of the plugin is also placed in the TBV plugins folder during program installation and accessible from the Plugins menu.

- **BOLD Decoder for Communication BCI.** The BOLD Decoder tool can be used for BCI applications such as multiple choice tasks or letter decoding. The tool provides the features described in the publication "Sorger, B., Reithler, J., Dahmen, B., & Goebel, R. (2012). A Real-time fMRI-based Spelling Device Immediately Enabling Robust Motor-independent Communication. Current Biology, 22, 1333–1338". The tool can be invoked by selecting the Bold Decoder item in the BCI menu.

- **Time Courses Container.** The new Time Courses Container allows to visualize time courses and beta plots within a grid layout, i.e. in a number of rows and columns. The zoomable visualization of time course data and estimated betas from all available ROIs provides a manageable overview and is helpful when comparing ROI data in detail, e.g. when selecting regions for neurofeedback applications. The new window can be invoked by selecting the Show Time Courses Container item in the View menu.

- **Display of detrended ROI time courses.** Time courses of selected ROIs in Time Course Windows of the main window and in the Time Courses Container are now displayed using linear detrending in case that a linear trend is added as a confound in the GLM design matrix. This option can be turned on and off using the D key toggle or the Display Detrended ROI Time Courses item in the View menu.

- **Visualization of Maps on Current Volume.** It is now possible to visualize calculated maps on the current volume using functional (e.g., BOLD) and other brain atlas mappings. This feature is accessible through the Visualization of Maps on Current Volume option in the View menu.
TBV - Basic Graphical User Interface (GUI)
The TBV Settings Dialog

The MasterTBV file provides the highest level of control by pointing to a "TBV Watch Directory". This directory may contain TBV Settings Files, which provide the next level of control about a particular run in a particular session.

**Red color:** These entries must be correct to ensure proper real-time processing. Check the red values and modify them if necessary. As an example, the "WatchFolder", which is the directory where the real-time data arrives, must be specified correctly to ensure successful data analysis.

**Green color:** These entries may be changed but they are not critical for proper real-time processing. Change these options to adapt the analysis and the display to your needs. As an example, you can chose to run 3D motion correction or not.

**Blue color:** These entries should normally not be changed. They reflect either important information which is automatically specified (i.e. by reading header information from the data files) or they reflect entries which are not (yet) used by the program.
The **WatchFolder:** entry specifies where the incoming data can be accessed for real-time analysis. Make sure to check this entry prior to any real-time analysis. You may also use options to automatically determine the most recent folder in a parent directory for some raw data formats.

The **TargetFolder:** entry sets the default directory in which the program saves the processed data (output directory). If this folder does not exist, it will be created (if possible) when starting real-time processing.

The **FeedbackFolder:** entry is only relevant in case that the *neurofeedback module* is used. In that case ROI intensity values that are (graphically) fed back to the subject are saved incrementally in that folder. As default, the value is set to the target folder but it can be changed, e.g. to a path ending in “feedback”.
The **Data Format** tab is used to specify the data type used at a specific scanner site. It also is used to specify the spatial properties of the data such as the size of single slices and the number of slices. For DICOM files, many of these entries are set automatically (are overwritten) if available from file header information.
Online Selection of Contrasts

Contrasts can be turned on / off during online processing. Major contrasts are defined automatically. Optionally, any contrast can be defined and used using a “Contrast file”.
Detailed ROI Functions

Time courses of single voxels can be easily inspected. Single voxels can be added or removed from ROIs, which is important for neurofeedback applications.
If anatomical data / preprocessing has been measured / prepared prior to functional runs of the subject, statistical maps can be visualized in various formats, including AC-PC and Talairach space as well as cortex representations.
If anatomical data / preprocessing has been measured / prepared prior to functional runs of the subject, statistical maps can be visualized in various formats, including AC-PC and Talairach space as well as cortex representations.
Projection of evolving real-time data (e.g. GLM contrast maps) on inflated cortex representation.
Projection of evolving real-time data (e.g. GLM contrast maps) on flattened cortex representation.
Univariate Statistical Data Analysis with GLM

Condition 1

Condition 2

Voxel Time Course

fMRI Signal (% change)

GLM (beta value)

Contrast: C1 > C2?

Statistical map
Fitting a GLM = Finding estimates of the beta values minimizing the sum of squared error values:

\[ y = Xb + e \]

Fitting a GLM = Finding estimates of the beta values minimizing the sum of squared error values:

\[ e'e = \sum_{t=1}^{N} e_t^2 = (y - Xb)'(y - Xb) \overset{\text{® min}}{\longrightarrow} \]

The solution can be directly calculated as:

\[ b = (X'X)^{-1}X'y \]
The beta values and inverted XX matrix can be updated incrementally using only information of the new time point with the following equations:

\[ b_{t+1} = b_t + (X'_t X_t)^{-1} x_{t+1} \frac{(y_{t+1} - x_{t+1} b_t)}{1 + x'_{t+1} (X'X_t)^{-1} x_{t+1}} \]

\[ (X'_{t+1} X_{t+1})^{-1} = (X'X_t)^{-1} - \frac{(X'X_t)^{-1} x_{t+1} x'_{t+1} (X'X_t)^{-1}}{1 + x'_{t+1} (X'X_t)^{-1} x_{t+1}} \]

The denominator ith:

\[ f_{t+1} = 1 + x'_{t+1} (X'X_t)^{-1} x_{t+1} \]
Recursive Least Squares

In its standard formulation, RLS GLMs result in the same beta estimates as a standard GLM over whole time course up to the current time point.

With a slight modification, RLS can be used to weight past values exponentially or to run windowed GLMs (Pollock, 1999).

```c
void RLS_GLM_Didactic()
{
    int y; // new value of current time point
    int k; // number of predictors
    double *beta = dvector(0,k-1); // betas to be estimated
    double **p = dmatrix(0,k-1, 0,k-1); // p -> invXX
    double *x = dvector(0,k-1); // row of design matrix of current time point
    int sign = 1; // standard or windowed RLS-GLM
    double lambda = 1.0; // 0 < lambda < 1 -> exponential weighting
    double *kappa = dvector(0,k-1);
    double f, *g = dvector(0,k-1);
    f = sign * lambda;

    for (i=0; i<k; i++)
    {
        g[i] = 0.0;
        for (j=0; j<k; j++)
            g[i] += p[i][j] * x[j];
        f += g[i] * x[i];
        y -= x[i] * beta[i];
    }

    for (i=0; i<k; i++)
    {
        kappa[i] = g[i] / f;
        beta[i] += kappa[i] * y;

        for (j=i; j<k; j++)
        {
            p[i][j] = (p[i][j] - kappa[i] * g[j]) / lambda;
            p[j][i] = p[i][j]; // invXX is symmetric
        }
    }
}
Real-Time Statistics – Design Matrix

Design matrix is incrementally build and can incorporate real-time data, e.g. separating error trials or adding incrementally calculated 3D motion parameters.

In order to remove low-frequency drifts, Discrete Cosine Transform (DCT) confound predictors may be added to the design matrix.

- predictors of interest
- DCT confound predictors
- motion confound predictors
- constant
Real-time fMRI

DEMO

(Recording of real-time fMRI run)
Current settings file: "NK_FFA_PPA_TAL-1.tbv".

Click the "Record" button to start processing.
Real-time fMRI Data Analysis @ 7 Tesla

ROI time courses
Real-time fMRI Data Analysis @ 7 Tesla
Real-time fMRI Data Analysis @ 7 Tesla

3T: ca. 30 x [64 x 64] = 122,800 voxels per time point
7T: ca. 50 x [192 x 192] = 1,843,200 voxels (multi-band sequence)

Activity follows cortical folds
fMRI Neurofeedback and BCIs

- Neural activity is transformed into digital code
- Feedback for learning of self-regulation of brain activity
- Decoding / translating brain activity for BCI application
Neurofeedback and the Hemodynamic Delay

Two-gamma function often used to model typical BOLD response

\[ y_1 = 6x^5 \frac{e^{-x}}{\Gamma(6)} \]
\[ y_2 = -x^{15} \frac{e^{-x}}{\Gamma(16)} \]
\[ y = y_1 + y_2 \]

-> Subjects need to learn to take into account 3-6 seconds delay
fMRI As a Therapeutic Tool?
Real-Time fMRI Neurofeedback
fMRI Neurofeedback as a Therapeutic Tool
• Real-time fMRI enables monitoring changes in the BOLD response \textit{online}.

• \textbf{Whole-brain coverage} of fMRI let subjects learn to influence own brain activity from \textit{one} or \textit{multiple} circumscribed (deep) brain regions or functional networks.

• The high spatial resolution of fMRI offers the possibility to investigate the control over \textit{localized} brain regions $\rightarrow$ \textit{Feedback is content-specific}.
Subject: Matthieu Ricard

Ventral striatum activation is modulated by intensity of positive mental states.
Training Effects in Beginners

Feedback Session 1

ROI

Event-Related Average Plots

Feedback Session 2
Neurofeedback in depressed Patients

Linden, Johnston, Healy, Goebel, Boehm, in preparation
First clinical results in depression after 4 sessions (4 weeks) NF assessed with HRSD score (higher values = more symptoms of depression)

Linden, Johnston, Healy, Goebel, Boehm (2011) submitted
Neurofeedback therapy for Parkinson patients

SMA - Neurofeedback target region

Figure 5. The functional improvement was apparent from the increase in finger-tapping frequency. Mean number of finger taps is shown for all sessions, with error bars showing the SD. Patients in the experimental group were able to increase the number of finger taps from session 1 to session 3 (the final assessment) \( p < 0.05 \).

BRAINTRAIN: A European consortium to develop methods and psychiatric applications of fMRI-NF and transfer technologies (10 partners from 5 EU countries and Israel)

Some planned improvements of clinical version of Turbo-BrainVoyager:

- Specialized “push-button” versions tailored to specific diseases
- Automatic ROI selection using thresholding and disease-specific atlas priors
- Connectivity feedback - e.g. windowed partial correlation as coupling strength
- Simultaneous fMRI-EEG neurofeedback, transfer fMRI —> EEG, fNIRS
Real-time fMRI: Multivariate Analysis Tools
Multivariate Data Analysis

The most simple case: two voxels

- Are the two sites connected?
- Do they interact?
- Do they jointly encode the stimulus?

Addressing any of these questions requires multivariate analysis.

Courtesy of Niko Kriegeskorte
Windowed ICA - Data-Driven rt-fMRI Analysis

- Automatically detects activation networks (no protocol required)
- Reveals dynamically changing activation networks
- Helps to automatically define ROIs for neurofeedback

*Offline ICA Example:*

Decoding Mental States Using Real-Time SVM Classifiers
Multi-Voxel Pattern Classifier

Advantages of multivariate, “pattern-based” analysis over massive univariate, single-voxel (GLM) analysis:

• Weak information at individual locations can be accumulated in an efficient way across multiple locations
• Integration weights for individual voxels can be learned by a classifier
• More fine-grained spatial information may be extracted from unsmoothed data
• Potentially allows (quasi) online estimates of a person’s perceptual or cognitive state after training, e.g. by comparing a new single-trial pattern of activity with learned patterns
• Potentially allows to reveal distributed representations, which would not be detectable with ROI averaging approach due to the higher sensitivity of pattern-based decoding approaches
Training a SVM Classifier
Training a SVM Classifier
Real-Time Testing of a Trained SVM Classifier

Trained classifier: Model_ROI_1_motor_imagery-mental_calculation-inner_speech_6-6-6.svm

- Estimation at end of trial
  - Pre-onset: 6
  - Post-trial: 4
  - Use trial duration
- Point estimation within condition
  - Pre-onset: 6
  - Hemo delay: 2
  - Post-cond: 0

Loaded "SingleTrialGLMSettings.txt" file:
- Adding linear predictor: 0
- Using trial duration for data window: 1
- Data window pre-onset: 6
- Data window post-trial: 4
- Estimating trial responses as percent change values
- Voxels will be excluded (estimated value set to 0) if intensities lower than: 100

Loaded "VoxelsUsedForTraining.txt" file containing 1238 voxels
Trial-Based Predictions of Trained SVM Classifier

![Real-Time SVM Classification GUI](image)

- **Trained classifier**: Model_ROI1_motor_imagery-mental_calculation-inner_speech_6-6-6.svm
- **Estimation at end of trial**: Pre-onset: 6, Post-trial: 4, Use trial duration
- **Point estimation within condition**: Pre-onset: 6, Hemo delay: 2, Post-cond: 0

Loaded "SingleTrialGLMSettings.txt" file:
- Adding linear predictor: 0
- Using trial duration for data window: 1
- Data window pre-onset: 6
- Data window post-trial: 4
- Estimating trial responses as percent change values
- Voxels will be excluded (estimated value set to 0) if intensities lower than: 100

Loaded "VoxelsUsedForTraining.txt" file containing 1238 voxels

Output printed if full trial data available

Starting incremental prediction...
- Time point: 17 last trial onset: 9 duration: 5 condition id: 2 predicted class: 1
- Time point: 37 last trial onset: 24 duration: 10 condition id: 3 predicted class: 2
- Time point: 62 last trial onset: 44 duration: 15 condition id: 4 predicted class: 3
Point-By-Point Within-Condition Predictions of Trained SVM Classifier
Real-Time Pattern Classification in TBV 3.0
Example: Detecting the locus of attention using SVM

Fig. 1. Visual stimulus employed in the experiment.
Real-Time Pattern Classification in TBV 3.0

Example: Detecting the locus of attention using SVM

Fig. 1. Visual stimulus employed in the experiment.

Fig. 2. Parieto-occipito-temporal cortex included for real-time multi-voxel pattern analysis.

Fig. 3. Visualization of the learned weights of the linear classifier on selected MRI slices.

Fig. 4. Multi- and univariate decoding results (n = 3).
TBV 3.2: Real-time feedback of deviation from desired activation pattern using SVM classifier
Online Decoding of Mental States
A Communication BCI for Patients with Severe Motor Impairments

TBV's Plugin Interface

The plugin interface:

• Opens custom access to internal data during real-time processing including information of ROIs, design matrix, raw data, beta maps and contrast t maps.
• Allows to perform additional calculations within the plugin and/or to export data for external processing, e.g. in Matlab.
• Provides direct pointers to internal data structures without any "buffering" for maximum efficiency
  -> high performance but careful programming needed in order to avoid crashes.

Plugins are coded in C++, optionally with JavaScript code for cross-platform GUI processing (dialogs). Code templates and examples are available to simplify creation of own plugins, e.g. to export accessed or calculated values for neurofeedback.
TBV 4.0: Integration of Atlas-Based Selection of Target ROIs and Networks